
Automated Pointing and Gain Measurements 

1.0 Why we check pointing and SEFDs before each experiment 

An initial check of pointing serves to verify that several aspects of the system are 
working correctly. 
 

1.1 Verify signal is getting from the front-end to the back-end 
 
The very act of checking the pointing and SEFDs using the detectors in the DAR 
verifies that signal is getting to the back-end. Each channel should yield the 
expected sensitivity and beamwidth. See also 1.5. 

 
1.2 Verify sensitivity 
 
The SEFD is a very useful measure of the antenna's sensitivity. Verifying that you 
get the expected sensitivity demonstrates that many parts of the system have not 
failed since the last more thorough check. 

 
1.3 Verify pointing is good 
 
Verifying that the pointing is good demonstrates that nothing serious has 
happened to the antenna's control system since it was last checked. 

 
1.4 Verify system time and date 
 
Depending on the details of the antenna interface, checking the pointing verifies 
that the date and time in either the FS computer or the pointing computer or both 
are correct at some level. If not both, you should verify the other independently. 
An error of 1 day will cause an approximately 1° pointing error. An error of a few 
seconds may not be detected depending on the size of the beam. 

 
1.5 Verify IFs aren't switched (many stations don't need this) 
 
If you switch IFs depending on the experiment, verifying the beamwidths and 
SEFDs of each IF is good check that they are connected to the correct channels. 

 
1.6 Things that can't be checked by pointing and SEFDs 
 
These are some of the items that aren’t verified by checking the pointing and 
SEFDs. They require some other means of verification that will typically be 
different at different stations. 
 

1.6.1 Polarization 
 
The sensitivity of the antenna is typically independent of the polarization. 
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1.6.2 Sub-band  
 
If you have more than one IF for a given band it may be difficult to 
distinguish between them based on the measured beamwidth. 

 
1.6.3 Time errors below the level detectable by the beam 
 
Unless the beam is very small you not be able to detect errors of even one 
second in time, much less a fraction of a second. 

 

2.0 Set-up 
 
There are several steps that are needed to set-up pointing checks in the FS. These need to 
be done once only. After that, the steps in the following sections can be expected to 
work. Please see the ACP User Guide manual, Section 5, in Vol.2 of the FS Manuals for 
more information on installing the system. 
 

2.1 "antcn" must support modes 0-5 (plus 8 for non-standard detectors) 
 
"antcn" provides the basic interface between the FS and the antenna. The listed 
modes must be supported for "fivpt" and "onoff" to work. Please refer to the FS 
Manuals Vol. 2, Station Programs manual for more information on implementing 
"antcn". 
 
2.2 Set-up the “.rxg” files. 
 
The “.rxg” files contain the gain calibration information for each band. It 
contains: LO values (or range if tunable), polarizations available, the gain curve, 
gain values (degrees per flux unit) for each polarization, and Tcal value as 
function of frequency for each polarization. , The set-up of these files is described 
in the default files in /usr2/fs/st.default/control/rxg_files 
(x.rxg and s.rxg). The part of the file name before the dot, “.”, can be 
anything, but should be chosen to be mnemonic for the band or receiver. Please 
make copies of the default files in your /usr2/control/rxg_file directory 
and if necessary make additional copies for each band you expect to use. The 
names aren't important, but must be unique within the directory. The FS will read 
in all files with the extension ".rxg", up to 20 of them. The comments in the 
default files should be self explanatory, but here are a few hints. The lines you 
should probably edit are: (1) the LO values, this must match the values used in the 
"LO=..." command for the RX you will be using; (2) the polarizations available 
"lcp" and/or "rcp"; (3) the DPFU(s) if you know it, they can be estimated as the 
Tsys in Kelvin divided by the SEFD; (4) if you have a gain curve in the form of 
"ELEV POLY" or "ALTAZ POLY", you can enter the coefficients on the 
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appropriate line zeroth order term first, if you have no gain curve, leave the value 
as "1.0"; (5) the tcal versus frequency table, if you have this information, if not, 
you can enter a single value in the band and the FS will use that for all 
frequencies; (6) do not put information for a given LO in more than one file, i.e., 
each LO should appear only once in all the files in the directory. 
 
2.3 "ctlpo.ctl" 
 
This control file specifies the sources that "aquir" will attempt to observe and 
what actions it will take for each. 
 
2.4 Customize "point.prc"  
 
This procedure library contains the pointing specific SNAP procedures that are 
needed by "aquir" and/or are otherwise general useful for pointing checks, 
especially with a dual S/X receiver.  
 

2.4.1 The “initp" procedure should completely set-up system 
 

This procedure is used to initialize the system before doing any pointing. 
It should fully set-up any equipment that is needed, including any station 
specific equipment. 

 
2.5 Customize "parpo.ctl" 
 
This file is used to control the editing of pointing data during the initial extraction 
of the data from the log. 
 
2.6 Customize "mdlpo.ctl" 
 
This file contains the standard FS pointing model. It is used by the pointing data 
analysis programs. If your "antcn" uses it also to calculate pointing corrections, 
the results of a pointing analysis are directly available to correct the pointing of 
your antenna. 

 
2.7 “flux.ctl” 
 
This file contains the source flux models. It should not need to be customized 
unless there are sources that you use that aren’t included. If so, please send them 
to Ed (weh@ivscc.gsfc.nasa.gov) and we will add them to default version as 
well. 
 
2.8  What if you have a non-standard detector 
 
If you have a non-standard detector, you can be able to support it using mode 8 
of "antcn". Two non-standard detectors, "u5" and "u6" are supported. The 
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implementation assumes you have some way to remove the signal from the 
detectors under computer control, e.g., by switching a large value of attenuation 
into the signal path. Please see the file /usr2/fs/misc/stndet.txt for 
details on how to implement this. Please note that the “Use” section in this 
document is out of date as of the writing of this document, but will be updated 
soon (contact Ed, weh@ivscc.gsfc.nasa.gov). Please see the help file for the 
“user_device” SNAP command for how to define the parameters for the user 
devices for gain measurements. 
 
2.9 What if you have no cal diode 
 
If you have no noise diode, set the diode noise temperatures in the station 
procedure "caltemps" to a negative value. The absolute value of the specified 
noise temperatures will be assumed by the pointing programs to be the system 
temperature. The antenna temperature due to the source will be calculated on this 
assumption, however the SEFDs will be unaffected. A value of -100 is 
convenient. The result will be that antenna temperatures will come out in percent 
of the system temperature (which may vary for example with elevation).  

3.0 Manual checks 
 
This section describes how to perform manual checks once the system has been set-up as 
described in the previous section. This is described in more detail in ACP User Guide 
manual, Section 3, in Vol.2 of the FS Manuals. Start the FS and enter the following 
commands in order: 
 

3.1 "proc=point" 
 
This command selects the "point.prc" SNAP library. If you are using a 
pointing library with a different name, such as "vpoint.prc", enter that 
library's name instead 
 
3.2 "initp" 
 
This command runs the "initp" procedure, which should have been customized to 
set-up your equipment for pointing checks. 
 
3.3 (source procedure) 
 
Here you enter the name of the source that you want to use to check pointing. The 
procedure libraries "point.prc" has procedures with coordinates and S- and X-
band fluxes for most of the useful Northern Hemisphere pointing sources. To see 
which are available, use the "dl" command in "pfmed", when "point" is the 
selected library. 
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3.4 "fivept" 
 
This command runs the "fivpt" program to peak on a source. It does this by 
measuring the power level on two slices through the source. Normally you would 
wait for the source to be acquired before typing this command, but if the antenna 
isn't onsource, "fivpt" will wait for up to one minute for onsource to be achieved 
before giving up. When "fivpt" finishes normally it prints an "offset" record. If 
some very nominal checks of whether this was a good peak or not are passed, the 
"offset" record will have two ones "1  1" at the end signifying success. The first 
four parameters in the “offset” record are: (1) first axis coordinate, (2) second axis 
coordinate, (3) first axis offset, and (4) second axis offset. The “xoffset” record 
contains similar information, but reports the first axis offset corrected for cosine 
of the second axis coordinate (the “cross” offset) and the sigmas of the offsets 
(first axis offset also corrected). 
 
3.5 "onoff" 
 
This command runs the "onoff" program to measure SEFDs and other antenna 
performance parameters. If you execute it immediately after "fivpt" has finished, 
you will get a "peak" performance measurement. 
 
3.6  (next source procedure) 
 
If you wish to make another measurement, select a new source. If the "fivpt" 
program for some reason returned unrealistic offsets, you may want to remove 
them before trying peak on the next source. See the sectioned “When finished” 
(below) for how to remove the offsets. 
 
3.7 When finished 
 
If you do not want the most recent “fivpt” offsets to remain in use (typically for 
geodesy we don’t), use "xyoff=0d,0d", "azeloff=0d,0d", or "radecoff=0s,0d"  (or 
wahtever offsets are desired) depending on the axis system of your antenna. 

4.0 What "fivpt" does 
 
A brief description of what "fivpt" does. 
 

4.1 Measure Tsys off source to calibrate scale 
 
This is the first step. It uses the noise diode to measure the system temperature off 
source. If there is no noise diode, indicated by "caltempX" < 0, then the negative 
of the specified diode temperature is assumed to be the temperature of the system 
off source. 
 
4.2 Scan both axes 
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The source is scanned on two axes, nominally aligned with the telescopes natural 
coordinates. Typically nine measurements, 0.4 beamwidths apart, are taken. 
 
The data are displayed in "lat" and "lon" records, These correspond respectively 
to the latitude-like and longitude-like coordinates of the antenna: EL/AZ, Y/X, 
and DEC/HA. The data in each record are: (1) the number of the point, (2) the 
seconds since the previous midnight of the scan (grows monotonically even if a 
scan spans another midnight), (3) the offset of the scanned axis, (4) the antenna 
temperature due to the source (above the system temperature), and (5) if the 
integration period is larger than one, the RMS scatter of the samples. 
 
4.3 Fit Gaussian + offset + slope 
 
The data for each axis are fit to a five parameter function consisting of a Gaussian 
(three parameters: peak offset, half-power beamwidth, and peak temperature) plus 
an offset and slope (in time). If the fit is nominally successful, the last parameter 
on the "XXXfit" line is positive. 
 
4.4 Repeat if not well centered or a fit failed 
 
For a typical set-up, if the peak for either axis is off by more than a half 
measurement step (this is perhaps too tight) or if the fit on either axis failed, the 
measurement will be repeated a second time. This assures that the source is 
roughly centered in the data set and is also helpful in the case of a weak source. 
For weak sources, if the beam is not well centered on the second axis scanned, the 
first axis scanned may not have enough signal from the source to find a clear 
peak. 
 
4.5 Leave the telescope "peaked" on source 
 
After the final scan, the offsets of the fitted peak are left in use. This is useful if 
you plan to run "onoff" next to find the "peak" performance. However, be careful 
after doing pointing checks to remove the last offsets before acquiring data, 
unless the source is strong and you will be acquiring data on that source in that 
part of the sky only (this is not the case for geodesy). 
 
4.6 Sample "fivpt" output 
 
9735612401440#fivpt#source cas-a      232109.0 +583230 1950.0 97/356.12:40:14  
9735612401445#fivpt#site GILCREEK 147.4976  64.9784   0.00 xxxx   0  1.00  0.00  
9735612401445#fivpt#fivept xyns  -2  9 0.40  1 3u  19.0  0.0834     399.1  
9735612401451#fivpt#origin   0.0000   0.0000   0.0000   0.0000   0.0000   0.0000  
9735612402363;calofffp 
9735612402806;calonfp 
9735612403043;calofffp 
9735612403066#fivpt#tsys 336.447  36.913  61.922  
9735612404069#fivpt#lat   1  45640.  -0.1334    1.158  
9735612404894#fivpt#lat   2  45648.  -0.1001    2.183  
9735612405769#fivpt#lat   3  45657.  -0.0667   11.597  
9735612410669#fivpt#lat   4  45666.  -0.0334   29.098  
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9735612411569#fivpt#lat   5  45675.   0.0000   38.361  
9735612412469#fivpt#lat   6  45684.   0.0334   28.832  
9735612413369#fivpt#lat   7  45693.   0.0667   11.370  
9735612414269#fivpt#lat   8  45702.   0.1001    2.556  
9735612415094#fivpt#lat   9  45710.   0.1334    1.227  
9735612415095#fivpt#latfit  -0.00032  0.0994 38.3030  0.5406  0.0035   4  
9735612415095#fivpt#laterr   0.00070  0.0020  0.5503  0.3844  0.0098   0.5838  
9735612415968#fivpt#lon   1  45719.  -0.1971    1.177  
9735612420869#fivpt#lon   2  45728.  -0.1479    3.239  
9735612421694#fivpt#lon   3  45736.  -0.0986   12.508  
9735612422569#fivpt#lon   4  45745.  -0.0493   29.294  
9735612423394#fivpt#lon   5  45753.   0.0000   39.025  
9735612424269#fivpt#lon   6  45762.   0.0493   30.376  
9735612425169#fivpt#lon   7  45771.   0.0986   12.768  
9735612425994#fivpt#lon   8  45779.   0.1479    2.594  
9735612430869#fivpt#lon   9  45788.   0.1971    1.531  
9735612430870#fivpt#lonfit   0.00110  0.1024 38.7746  0.6563 -0.0033   5  
9735612430870#fivpt#lonerr   0.00111  0.0022  0.5846  0.4250  0.0108   0.6198  
9735612430870#fivpt#perform    2.041   637.4    0.509    8.223  
9735612431562#fivpt#offset  332.6681   47.5413   0.00110  -0.00032  1  1 
  

5.0 What "onoff" does 
 
The "onoff" program is a simple tool for measuring the SEFDs of the antenna in two 
detector channels simultaneously. 
 
The following measurements are made, typically with two iterations for everything 
except the no signal case: 
 

5.1.1 Power on source  
5.1.2 Power on source with noise diode on 
5.1.3 Power off source with noise diode on 
5.1.4 Power off source with no signal for “zero” 

 
A final set of power onsource and one source with noise diode on are included to make 
the measurement procedure symmetric in time. 
 

5.2 Final results printed on one like for each detector: Gain Compression, Tsys, 
SEFD, Tcal in Janskys, Tcal ratio. For interpretation of the last two items, please 
see the notes for the Antenna Gain Calibration and Pointing and Single Dish 
Amplitude Calibration classes. 
 
The results are printed in several forms to facilitate analysis depending on what is 
needed. You need to be careful of Tsys and Tcal ratio values on the accuracy of 
the "caltemp" values. The Compression, SEFD, and Tcal in Janskies do not 
depend on the “caltemp” values. 
 
5.3 Sample final results from "onoff" output 

 
2002.310.20:49:31.27#onoff#    source       Az   El  De I P   Center   Comp   Tsys  SEFD  Tcal(j) Tcal(r) 
2002.310.20:49:31.28#onoff#VAL cygnusa    273.4 52.0 1u 1 l   4969.99 0.2658 18.34  438.0 487.272 2.8850 
2002.310.20:49:31.28#onoff#VAL cygnusa    273.4 52.0 2u 2 r   4969.99 0.2548 16.83  421.3 480.612 3.0234 
2002.310.20:49:31.28#onoff#VAL cygnusa    273.4 52.0 3u 1 l   4977.99 0.2869 17.70  435.2 501.462 2.9690 
2002.310.20:49:31.28#onoff#VAL cygnusa    273.4 52.0 4u 2 r   4977.99 0.2673 16.78  425.8 487.400 3.0661 
2002.310.20:49:31.28#onoff#VAL cygnusa    273.4 52.0 5u 1 l   4985.99 0.3214 17.25  445.8 527.168 3.1212 
2002.310.20:49:31.29#onoff#VAL cygnusa    273.4 52.0 6u 2 r   4985.99 0.3032 15.81  422.6 513.282 3.2289 
2002.310.20:49:31.29#onoff#VAL cygnusa    273.4 52.0 7u 1 l   4993.99 0.3533 16.68  452.2 553.065 3.2745 
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2002.310.20:49:31.29#onoff#VAL cygnusa    273.4 52.0 8u 2 r   4993.99 0.3353 15.39  431.3 537.976 3.3842 
2002.310.20:49:31.29#onoff#VAL cygnusa    273.4 52.0 9u 1 l   5001.99 0.3684 16.45  455.1 564.312 3.3411 
2002.310.20:49:31.29#onoff#VAL cygnusa    273.4 52.0 au 2 r   5001.99 0.3464 15.14  430.8 546.332 3.4368 
2002.310.20:49:31.29#onoff#VAL cygnusa    273.4 52.0 bu 1 l   5009.99 0.3959 15.67  454.0 591.040 3.4993 
2002.310.20:49:31.30#onoff#VAL cygnusa    273.4 52.0 cu 2 r   5009.99 0.3710 14.79  437.0 567.122 3.5676 
2002.310.20:49:31.30#onoff#VAL cygnusa    273.4 52.0 du 1 l   5017.99 0.4232 15.43  468.8 619.723 3.6691 
2002.310.20:49:31.30#onoff#VAL cygnusa    273.4 52.0 eu 2 r   5017.99 0.3912 14.57  444.4 585.618 3.6839 
2002.310.20:49:31.30#onoff#    source       Az   El  De I P   Center   Comp   Tsys  SEFD  Tcal(j) Tcal(r) 

6.0 Automated measurements 
 
This section describes what is needed for automated measurements. This is even easier 
than doing manual measurements. Start the FS and enter the following commands in 
order: 
 

6.1 "proc=point" 
 
This command selects the "point.prc" SNAP library. If you are using a 
pointing library with a different name, such as "vpoint.prc", enter that 
library's name instead. 
 
6.2 "acquire" 
 
This procedure starts the "aquir" program running. Typically "aquir" uses the 
"ctlpo.ctl" control file and the log is changed to "point.log". However 
both can be changed. For example, you could make a version that uses only the 
very strongest sources for a quick pointing check and returns the offsets to zero 
when stopped. Once started, "aquir" runs indefinitely until it is "kill"ed. 
 
6.3 To stop: "kill" 
 
The "kill" procedure will stop any of "fivpt", "onoff", and "aquir" that happen to 
be running. Typically it also changes the log back to "station.log". "kill" 
does not normally change the offsets back to zero. Follow the procedure under 
"Manual Checks" to do that. 
 

7.0 Pointing Data Analysis: "pdplt"  
 
This section describes the use of the “pdplt” program to analyze pointing data to 
determine a pointing model. The "pdplt" program is a Tcl/Tk application that provides a 
graphical front-end for the text based pointing data analysis programs. It is run by typing 
"pdplt" to a shell prompt. A brief sketch of some of its capabilities follows. More 
information can be found in the “pdplt”`documentation available on the FS servers.  
 

7.1 Selecting a New input file 
 
To select the input file, click on the "File" main menu entry and then select 
"New". You can type just the name portion of a FS log file, by default it will look 
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in "/usr2/log" and add the ".log" extension. You can load a "point" log file 
even while pointing data is being written to it for a check of the results "so-far". 
 
7.2 Selecting an existing input file 
 
Click on the "File" main menu entry. There is an "Open" option that can be used 
to open an existing "xtrac" output file such as was saved by the "Save" option on 
this menu.  
 
7.3 Examining sky coverage 
 
The first plot that is shown is of sky coverage. This is done in the natural 
coordinates of your antenna assuming that the "parpo.ctl" control file has 
been set-up correctly. You can select which graph to look at using the "Graph" 
menu to select which graph to examine. The letters "n" and "p" can be used to 
move the next and previous graphs respectively (with wrap around at the ends). 
See the attached plot of sky coverage for a pointing data set from Tsukuba. 
Ideally, the entire sky should be covered more or less uniformly. 
 
7.4 Points on the plots 
 
Points that are included in the solution are shown as solid circles. Points that are 
deleted are show as open circles. Information on individual points is displayed 
when the pointer comes over or near it. On the residual plots all included points 
are shown by default on the interior of the plots when they have been auto-scaled. 
Any points that lie outside the range of the plots are shown on the edge. Points are 
normally shown with one-sigma error bars, but these can be turned off. 
 
7.5 Residuals, random versus outliers and non-random  
 
Ideally the residuals of the pointing solution should appear to be a random scatter 
about zero offset with a Gaussian distribution for both offsets types against both 
axes (four plots). Two major reasons they might not be are: (1) so-called 
"blunder" points, which are just points that lie a lot farther from zero than other 
points in the vicinity, due for example, to some failure of “fivpt”, and (2) 
systematic trends in the data, such as slope or sinusoid pattern in the residuals. To 
correct the former problem, you can remove a point by editing it out of the data, 
see "Editing Data" below. The latter problem usually has to be dealt with by 
changing the model, see "Changing the Model Parameters" below.  
 
There are two attached plots show residuals for Tsukuba. In one plot, elevation 
offset versus elevation, the residual distribution is acceptably random. However, 
there is a hint of systematic effects at high elevations, probably due to Taurus-A. 
The other plot azimuth offset versus azimuth would not be acceptable except that 
the magnitude of the systematic is so small. Interestingly the large positive points 
in azimuth offset near 180º azimuth are for one source only, Taurus-A. It is not 
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clear how to remove this particular variation since it seems to be associated more 
with the source than the particular part of the sky involved. This is still being 
investigated. Fortunately it is small enough so that it is not a problem even if it 
isn't resolved. 
 
7.6 Viewing individual sources 
 
Individual sources can be highlighted by selecting them from the "Source" menu 
item. This is useful for identifying which points go with which sources and to see 
if there is any source specific systematic behavior. Using this feature is how the 
fact that Taurus-A sticks out was discovered in the Tsukuba data. Highlighting 
can be turned off by selecting the "No Source" option. 
 
7.7 Viewing the raw data 
 
When testing to see if a new pointing model is needed, it is useful as a first step to 
examine the raw data. You can select to view the raw data from the “Data” main 
menu. The choices on the menu are “raw data” and “residuals”. If you select “raw 
data” the plots and statistics (see next sub-section) will refer to the raw data rather 
than the default residuals to the latest solution. 

 
7.8 Statistics 
 
The number points used and available are shown in the lower right of the display 
in the format used/available. 
 
The average and RMS scatter of the residuals for both axes can be shown by 
selecting the "Statistics" menu item. If the average error for either axis isn't zero, 
for the residuals something is wrong. The RMS scatters for a good solution would 
typically be 10% or less of the half-power beamwidth. 
 
7.9 Editing data 
 
Strictly speaking data should never be edited. However, in the words of an 
applied math teacher I once had "real data is nasty stuff". In other words it has all 
sorts of "blunders" and errors that make some points simply invalid and mess up 
the results. The problem is that strictly speaking without a priori knowledge there 
is no way to tell for sure which points are blunder points and which are really 
telling you that there is something with your pointing model form. Fortunately, 
with pointing data, in most cases it does not matter. However, editing needs to be 
done conservatively in any event to be safe. 
 

7.9.1 3-Sigma editing 
 
One of the most defensible forms of editing when there are a lot of data is 
to apply a “X-sigma” criteria, "X" is usually 3. In other words if a residual 
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differs from zero by more than three times its sigma, it should be removed. 
For well distributed data, typically 1% are removed under a 3-sigma 
criteria. The "Edit" menu item has a “x-sigma” option to apply this criteria 
uniformly to all the data on both axes. Afterwards, the data should be 
reprocessed by selecting the "Reprocess" option on the "Edit" menu item. 
It may be necessary to iterate the X-sigma edit and reprocessing several 
times before the no more points are removed. This process will fail if the 
residuals do not have a Gaussian distribution, because in most such cases 
the editing will progressively remove more data on each step until there 
are no data left. If that happens, you need to investigate why the residuals 
do not have a Gaussian distribution. If possible this should be corrected, 
perhaps by changing the model. If not, you will need to stop after one or 
two iterations.  

 
7.9.2 "Point and shoot" manual editing 

 
A somewhat less defensible approach is to manually delete any points 
with residuals that differ significantly from zero relative to their error bars. 
This is a somewhat artistic process. It is needed sometimes to remove big 
outliers either because there aren't enough data to apply a 3-sigma criteria 
or some other reason. Since the plot limits include the extent of error bars 
on points it is sometimes helpful to delete points that have very large error 
bars. These points usually do not contribute anything significant to the 
solution. If their error bars are very large compared to the bulk of 
legitimate points it is likely that they are blunder points anyway. However 
you have to be careful of azimuth offsets that have large error bars at high 
elevations, these may be legitimate and significant. After manual deleting 
any points that need to be removed, be sure to reprocess the data using the 
"Reprocess" option. 
 
To add or remove a point manually, place the pointer on or near it and 
click on it. The point selection is slightly sloppy because it was found to 
be hard to use otherwise. After editing out or adding back in points, be 
sure to reprocess the data using the "Reprocess" option on the "Edit" menu 
item. There is also a "Add all points" option on the "Edit" menu item to 
return all points to the solution.  

 
7.10 Sigmas 
 
Three types of sigmas are available for use or display in “pdplt”. The default 
sigma, the a priori, is the most useful and is the only one that is normally needed. 
(You can stop reading this paragraph at this point and skip to the next sub-section 
unless you want to know more about this.) This value combines the effect of the 
raw observed sigma with the added noise for each axis that had to be applied to 
make the reduced Chi-square of the solution come out close to unity. This 
provides in some sense the best available estimate of the true sigmas of the input 
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data. The other types are: (1) "input", which is just the raw observation sigma and 
doesn't included an added noise contribution, this is useful mostly for curiosity 
and (2) a posteriori which is the sigma of the residuals after the solution, rather 
than of the input data. Ideally the a posteriori value should be used for all editing 
operations, but in practice it is difficult to explain what it is to people and for 
pointing data, except in situations with very sparse data, is virtually identical to 
the a priori sigma. If the data are sparse enough that there is a significant 
difference between the a priori and a posteriori sigma then there probably aren't 
enough data to make a good solution anyway. Consequently, the a posteriori 
sigma is mostly a curiosity as well. 
 
7.10 Printing plots 
 
Plots can be printed individually either directly to the printer or to a file. The 
output is PostScript. Select the "Print" option from the "File" menu option. 
 
7.11 Saving the results 
 
The results can be saved using the "Save" option from the "File" menu. The data, 
including any editing, is typically saved to file with a name of the form 
"xtrYYYY.DDD" in "/usr2/log/", where "YYYY.DDD" is the last digits of the 
year and day of the year. The date is taken from the log the data were extracted 
from. This file is the format of an "xtrac" program output file and can be read into 
“pdplt” again using the "Open" option in the "File" menu option. The results of 
the analysis are saved in a file of "errYYYY.DDD".  This file is in the format of 
an "error" program output file. This file is used by in updating model step 
described below. The options for saving the data can be modified using the "I/O 
Setup" option from the "File" menu item. 

 
7.12 Update the model with "update YYYY.DDD" and restart the FS 
 
Once the analysis has been finalized and the results saved as described above, the 
model can be updated. Issue the command "update YYYY.DDD" while in a shell, 
where "YYYY.DDD" is suffix of the "errYYYY.DDD" file created when the 
results were saved. The suffix doesn't necessarily have to be in the format of 
"YYYY.DDD" as long as it is specified as the argument for "update" and agrees 
with the actual suffix to “err” in the file name. The "update" program will 
comment out the last model in "mdlpo.ctl" and append the new one. To begin 
using the new model, stop the FS and restart it (or do whatever is necessary to 
have the model read in if your "antcn" doesn't read it automatically at start-up).  
You should always do at least a quick pointing check to make sure that the new 
model is good before using it. 
 
7.13 Changing model parameters 
 

 12



Automated Pointing and Gain Measurements 

If during the analysis of the data, an unmodeled systematic is discovered, it is 
possible to modify the form of the model to remove this. The default model has 
several parameters beyond the basic eight. These can be turned on and off in the 
analysis by using the “Modify Parameters” item in the “Edit” main menu and then 
selecting “Reprocess” to see the results. Please note that making changes here 
does not permanently change the values used in the “mdlpo.ctl” file. It only 
changes parameters used for the current analysis session with pdplt. However, if 
you change the parameter settings, save the results of an analysis with them and 
then update the “mdlpo.ctl” file, the new model in the “mdlpo.ctl” file 
will use the new parameter configuration. This behavior is generally the most 
useful. For more information on the flags and their values and the parameters that 
are available, see the Pointing Model File manual (ACP Files) in Vol. 2 of the FS 
manuals. If the parameters that are available are not sufficient, they can be 
expanded. 
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